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Want to build a Web site? We'll show you how

s ow would you like to create your own
Production Editor s .
Lorraine Mullaney Web site and get it on the Internet for
lorraine.mullaney@futurenet.co.uk \ the whole world to see? Well, here's your
Contributing writers: < ; -~ chance. All you have to do is
Paul Douglas, Ed Haynes, 3
Simon Pickstock. Brian Smith fOI,IOW the,easy,' Ste? bysiep
; instructions in this book and
Contributing art: y: A
Nustration: : you'll have your own
Mike Roberts, Kevin Jenkins homepage on the Internet in

Photography: 57 i
Simon Dodd > A S 2l | next to no time!

You don't need a degr
Publisher Nathan Berkley < dgt . aree
nathan.berkley@futurenet.couk in computer programming or
Assistant Advertising Manager graphic design to be able to build an attractive-looking
Carol Christie Web site. All you need is a computer, some free
coldritieBfitirenetcoLk software, which you'll find it on Internet Advisor's
Internet Advisor editorial is at cover CD every month, and this little book.
30 Monmouth Street, F i
Bath BA1 2BW You'll be amazed at how easy it is to put a
Tel ™ 01225 442244, homepage together just by following our

Fax = 01225 822744

straightforward instructions. First we'll show you how
to make your own Web page. Then we'll show you
how easy it is to add images to that page and expand
it into a complete Web site. And, last but not least,
- we'll show you how to get your Web site up on the

Internet. So let's get started...
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@ Introduction to FrontPage Express

Building your own Web site is as easy as using a word

HOW tO processor with FrontPage Express...

Use FrontPage _

Creating good-looking graphical Web sites used to be a

task reserved for the professional Web designer. Now

there are plenty of software programs around to make
the process so simple that it can be done by any novice. On the
next few pages we'll show you how to create great looking Web
pages with Microsoft's FrontPage Express. This simple Web

o= page creator comes free with Internet Explorer and

can be installed from the Internet Advisor cover
CD. For further information about the cover
CD and the software on it, please refer to
the magazine.

FrontPage Express
The great thing about FrontPage Express is that

’ you don't have to be a programmer to use it.

tage Express...

A 2

Smaller Colour Image
Increases the Decreases the Enables you to Add an image to
size of your text size of your text colour your text your page
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The program is similar to Microsoft Word so you can style and format
your text using the same shortcuts and menus. If you are prepared to
experiment then you'll find that FrontPage Express is quite flexible,
although it lacks some of the fancier features found in other editors.
On the following pages we'll show you how to set up and lay out a
basic homepage, then add images to it. We'll show you the best way of
including images while drastically cutting download times. Then
we'll add some of the more advanced features, such as ﬁ
sound and video. %
There are a number of ways to \

This software is for
PC users. If you
have an Apple
Macintosh turn to
page 22

Software:
FrontPage Express
Project:

Creating a Web
page, laying it out,

adding and sizing

make your Web page look more pictures, adding
exciting. All you need is some sound and video
ideas, some captivating text, and
the basic ability to lay the page out
in some semblance of order. So, turn
the page and let the building begin...

@ i+ |E== B L U
Link Indent tool Alignment Bold
Add a link from Increase or decrease  Align your text: Add styling to your
your Web page the indentation of left, centre text: bold, underline
to another your text or right and italic

Build your own Web site @ Internet Advisor o
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@ FrontPage Express e Creating a basic homepage

STEP FrontPage Express comes

ﬁ free with IES, but itisnot | companent Options
U:‘ installed by default. If Choose specific Internet Exploter companents or change the installation location here.
FrontPage Express is not
already on your system, you need - d
to go to the CD, choose to install ! E i
Internet Explorer 5 and choose [Custom 2 A;muemm poasss
the Custom Install option. You will = @ Web Authoring Components 2] | edting of Web pages with
see a list of options. Scroll down % g bl G
until you find FrontPage Express [ Web Folders {
and tick the box next toit. It's not LI Vitual Baie Seamptina Suppot o |
instantly obvious where 4 I <
FrontPage is on the programs Eorrooelyippeanakiboc Jel ol ks T
menu, butjust goupto | TOSImHESEME S B
Accessories, Internet Tools and o et x| heo |
then FrontPage Express.

H FrontPage E) - [Untitled Normal Page]
S$TEP On starting the program, o e , i Hm e

&) you are presented with S5 u pIEER o EE e
é a blank page. You can go g m’@

to the File menu, click

New and choose one of the page
wizards, but they are fairly .
uninspiring. We've decided to N
create a page about Stonehenge
using some photos we've taken
ourselves, but first we need a title.
Click on the centre justification
button, choose a font colour, and
type in your title. Highlight it, and
use the Increase Text Size button
to make it bigger.

0 Internet Advisor e Build your own Web site
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Stonehenge
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ngneerg. one carrt kp but be mmazed a1 the sk and precision mvolved Oue of th
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dred mies
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STEP We are still on central
%’) justification, so press the
) Left Justify button and

hit return a few times.

Now we need to enter an

introduction, which needs to be

short to hold the interest of any
visitors. Unfortunately FrontPage

Express doesn't have a

spelichecker, so make sure your

spelling is up to scratch, as your
page will soon be on display for
all to see! As you would do when

riting a letter, make sure you
split your text up with paragraphs
at the appropriate places.

STEP When you read a book or
A z magazine, you will notice
b= 3 that the text does not go

to the very edges of the
page. A Web page should be the
same, and you should not be
afraid to use a fair amount of
white space. Reading a solid lump
of text which stretches right
across the page is hard on the
eye, so use your mouse to
highlight your text and press the

Increase Indent button. Once
should be enough, but
experiment to see what suits you.

Build your own Web site @ Internet Advisor o
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STEP Having text only on your
( j’ page is going to be
(.7

pretty boring so it's

time to add some

pictures. To add a background image,
right-click on your page, select Page
Properties, and select an image.
Make sure that your images are in
the same directory as your Web
page, and that you only enter the
name of the image i.e. image.jpg.

If you put in c:\Web\image.jpg

for example, the image

won't appear when

you put your

page on the Web,

STEP While a background image
might add a little colour

@ and interest, foreground
images are the real key to

Web pages. However, don't be
tempted to just add images willy-
nilly, as any image on your page
will increase the time it takes to
load. To add an image, simply
click the Add Image button (all
the buttons have a descriptor if
you place the mouse over them)
and use the justification or
indents to place them, again

taking care to just enter the
image name.

General Bmluuw’wl Custom |

| ¥ Esdawad s I Wotemsk

[ Defout

; [back o
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STEP It's good practice to
Gereral | Background | Margns | Custam] C ) give your Web pages a name,
Locsiore  [RID Aempiohenbin / which will be displayed in the
Titer Foieicone 1o Storeherge top left-hand corner of your
Base Locatonr | Browser's window. Calling a page
g.:::rm M ‘ipdex’, ‘menu’ or ‘Steve's homepage
Documet BeadogDsectore [ingy | gives your readers more of an idea of

what your page is about. To name your
page, right-click on the page and

select Page Properties. The second box
is where you should enter your page's
title. At this stage you
should leave all the other
settings as they are.

STEP So you

@) havea

R o030 w wvatery aod xite of () basic Web page but now
were able to construct such a feat you need to save it so
that you can place it on the Web
and visitors can gaze upon its
glory. Now when you come to
save your page, FrontPage
Express will try to save it to the
Web. As you won't be connected
to the Internet permanently, you
want to save it to your hard drive
first, so choose the option Save
as File, and place it in the same
directory as your images. Voila!
Your first Web page.

Build your own Web site e Internet Advisor °



‘ FrontPage Express e Laying out your homepage

STEP One of the best ways of
gw\) laying out your page is
> 4

to use tables. To add a

table, click the Insert

Table button, and choose how
many rows and columns you
want. To put your images into the
table, click on Add Image, use the
Edit menu to perform a cut
operation, then place the mouse
cursor in a table cell, and use the
Edit, Paste command. Do this for
each image, and then add a
caption in the cell below

each image.

STEP By default, the text will
7/\ align to the left of the
\./ cell. To centre it under
each picture, highlight

the text and press the Centre
Align button. A new table does not
have a border around it, so if you
want to add one, right-click
anywhere in the table and choose
Table Properties. A new window
appears and here you can add a
border by increasing the border
width to 1, changing the
background colour

or even specifying a width

for the table.

puctiege i
hues on tiere
e | i g id

e TG
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STEP The World Wide Web is all
{'“/ A about linking and sharing
UU information, so we want
to add some links to our
page. Adding a link is a very
simple affair: simply highlight the
words you want to use as a link,
and click on the Add Link button.
You will need to enter the Web
site address. Make sure the link is
exactly the right format, e.g.
http://www.futurenet.co.uk,
or the link won't work. If in doubt,
simply copy the address from the
location bar of your Web browser.

STEP Linking pages within
[1¢&) your own site is even
UZJZ easier. As the new page
will be on the same site
and in the same directory, you
only need to enter the name of
the page you are linking to. This
is known as a relative path. Once
again, highlight the text you want
to use as a link, click on the Add
Link button, but this time in the
Web site address box, delete the
“http://" part and type in the
name of your new page:.
page2.htm for example.
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STEP |f you have a large page
] with lots of information
[/ onit,it's quite handy to
be able to jump directly | f
to individual sections. To do this | ot 2 2 oy ma e of miet
you create a bookmark and then : 3k el
create a link to it. For instance, to
jump back to the top of the page, | § 1 O
turn the title into a bookmark. ; e Nty i simiog o
Highlight the title, go to the Edit
menu and choose Bookmark. Call
the bookmark ‘top’ and click OK.
A dotted line will appear under
the link, but won't show up on
your actual Web page. #

nioved over wich s immmense
Pt t0 visit Stonhienge, you
fo

STEP Now we have a (35 i & r= o i 0m om e
—!

nﬂ bookmark,we DASBiE plEEE 1 22 =X
/57 wanttobe

able to create

a link to it. Type in a line of text
saying something along the lines
of ‘return to top of page'. Now
highlight the text and click on the
Add Link button. Choose the
Open Pages tab at the top of the
window, and go to the box called
Bookmark. Choose the one called
‘top" and click OK. Now you'll find
that if you click on the link, you
will jump to the top

of the page.

nd out moce

1 pass which wil

Wi s

0 Internet Advisor e Build your own Web site
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S a2 ooty o T oo
[ S femvtow = AN BZzU PDEER ay EE R
OSSR S0 the o AWMT S ~~DOfr N
S @0

i

EP Now that we have
[ 1,/’2 created our Web pages,

P
| /=/ we want our visitors to

be able to tell us how
impressed they were by them.
The simplest way of enabling
them to do this is through email.
So we need to create an email

Tellmie bow waachs you bked oy pages by STTEERYE

Kekow g oy &
. TN et |
™ haon prge whach wil
e R e I R R E T S
o back e top, ¢f the pags

link. Add some text for example,
‘email me now', and again,
highlight it and choose the Add
Link button. Under link type
choose 'mailto’ and type your
email address in the Web site
address box.

sy DEEA
AT e --Nojue

|
0cR a0 12w

STEP Now everyone can email
B o

[ <J you, but wouldn't it be

SmeeBa

T K
Stouchage wd the swron
aforuishon on e § gkl

There we dots of oftwe
~tell you a8 about

S A = oy |

1 bete cvcie

I w handy if you could know
instantly if that email
came from a visitor to your Web
site? Highlight your email link and
click on the Add Link button, and
click at the end of your email
address. Now add, without any
spaces ‘?subject=Your Web page'.

fad out more

ot pags Wech wil

Now any emails arriving from

Tell nue bow emsch you Bed nry pages by ST

[ st

visitors to your page will have the
subject line Your Web page', and
that's pretty handy! Now you're
an expert and it's time to improve
your site even further...

s

Build your own Web site @ Internet Advisor @
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STEP Using FrontPage Express is
I just like using a word
processor such as Word or
WordPad. This means that
you can style text for emphasis in the
same way: you can either highlight it
and use the style buttons, or use
shortcut keys. The shortcuts are the
same as for any Windows program, so
CTRL + B will put text in bold, CTRL +

“»\,

FrontPage Express - [Untitled Normal Page]

(4 Ele Edt View Go [nset Fomst Toos Teble Window Hep
a8
;“ﬁm’ﬁ ‘ @

ITmesNewRomen
e
M@EF @0

J
-3

Unduhe

This is normal text

This 1s BOLD text

This is ITALIC Text

| will italicise text, and CTRL + U will
underline text. However, underlining is
not recommended in Web pages as it
may be confused with a hyperlink

(his is UNDERLINED text

Thus 15 a hyperhink

(see Jargon Buster on page 23).

=y,

SYEP One of the best things
nE about using
FrontPage Express, is
that it's easy to use
colour to add emphasis. To add
colour, select your text with

\ 7/ 3 the mouse and click the Text
12 Colour button. You can choose
) from a set of default colours or,
=] .‘ if you click on 'Define custom
e colours', you can choose your
own shade. Be careful that
your text does not disappear
into the background; dark blue
text on a black background is
difficult to read!

@ Internet Advisor e Build your own Web site
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Introduction
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STEP If you want to put a lot of
F) information on your Web
page, but you don't want
it to read as a single block
of text, there are a number of ways
to break it up. Adding paragraphs
is the most obvious way, but what
if you want to separate two pieces
of text in a more obvious manner?
This is where you can use a
horizontal line. To add one, simply
go to the Insert menu and select
Horizontal line, Right-click on the
line to edit its properties, such as
colour and width.

STEP Inputting text is as
oo \ easy as typing a

3 letter for all the
reqular characters
that you would normally use.
However, if you want to add
special characters, such as a
copyright sign, or an accent on a
letter, then things are a bit
different. In HTML (see Jargon
Buster on page 23) you would
have to enter a special code, but
\ in FrontPage Express you simply
R\ go to the Insert menu, choose

() Symbol and select the special
\J character you want to insert.

Build your own Web site @ Internet Advisor Q
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STEP 0K, s0 now we know %‘““g; S —
&[] howtodoall the = S fetion =] Ax (52U D EZZ
(5L basics it's time to DSE &R @~ BET @ ~~DO [T K
add some cool S@EF - BO :
stuff! It's great to have lots of
visitors to your site, so why not When this page. spens; yorwill hear soe-wricoming you ta sy hemepage.
let them know by welcoming
them personally. How do we do Ot Locain |
this? Well, by adding sound. If you . Frmple
have a sound file that says freicome warl Bowe. |
‘welcome to my homepage' we ol
can make it play every time you I
have a visitor. Go to the Insert
menu, choose Background Sound
and choose your file.

STEP The only disadvantage
& ,5/ with embedding a
& /£ background sound is
that it will only play

when the page is first opened. If
you have a file that you want
visitors to be able to play again | When this page opens, you will hear me welcoming you to my homepage.
then a different method is
required. Click on the Add Link | Click the lmk below to play the wave file

button, and instead of entering a
Web site address, enter the name Open Pages Word Wide Web | New Pags |
of your sound file, for example:

welcomewav. When a visitor Hipeirk Type 2]
clicks on the link your sound URL: [weicome. wan]
will be played.

@ Internet Advisor e Build your own Web site
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FiontPage E¥pieis - jD:Memp\blmh\usinghtm]
t_Tooks Table Window Help
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STEP If you want your
&) visitors to be really
impressed, you can
even add video to your
Web page. Go to the Insert menu,
choose Video, and enter the name
of your video file. You can choose
whether the video starts to play as
soon as the page is opened, or
when a visitor places the mouse
over the picture of the video. It's

——

™

best to choose the latter, so right-
click on the video, choose the On
Mouse Over option, and uncheck
the On File Open option.

STEP Anyone who's seen
&)/, ] the scrolling electric
ZJ/LJ signs in places like
Piccadilly Circus will
know how eye-catching they are,
and it's easy to add one to your
Web page for that added impact.
Click on Inset, select Marquee,
and enter your text into the text
box. You can choose how fast the
text moves, which direction it
takes, and even how far
across the page it moves.

Build your own Web site @ Internet Advisor @
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STEP You already know how
= to put pictures on
/4= your Web page, using
- the Insert Image

button. Let's have a look at the
process in more detail, as pictures
are an important part of a
professional Web page. When you
first place a picture on a page, it
is unlikely to be the ideal size,
hence it needs to be re-sized. If
you click on the image, you will
see grab handles appear at the
corners and mid-points, and the
cursor alters when over a handle.

STEP  |f you grab a handle
&)@ and move the
‘/’év‘\g/ mouse, you can
make the picture

larger or smaller. Generally,
smaller pictures are better as
they decrease the loading time of
the page. However, using this
process does not change the size
of the image file, just the size of
the picture on the page. What
you are effectively doing is
forcing the image to appear in a
smaller frame.

@ Internet Advisor e Build your own Web site
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STEP Once you have re-

left >inbsp. </ P>
left >inbspi</p>
1af e \Cmben ' 2 8

rong>St—

E (\”‘, sized the image to
/ \/L ’ the correct
proportions, let go
of the grab handle. Now we
need to know the size of the
image, so go to the View menu,
and select HTML (see Jargon
Buster on page 23 of this
book). Find the part of the code
that refers to your image - in
this case it is the part that
says: img src="stone2.gif"
- and make a note of the

_Hee | width and height attributes.

4] | _’r
€ Ojprsl G et 7 Show ColorCodeg. o | e |
e e

* Pyl Size

widh [0 = « Heght [172 3

- C Parcentags of Orignal

wwhl——axﬁmr—?

Resze Type [Smart sze >
¥ Resge Al Layers
¥ Maintain aspect ratio of 2116402 to

k] el |

Heo |

STEP Using a graphics program
5 /\; such as Paint Shop Pro, open
your original image, and
choose the Re-size option.
Enter the width and height attributes
which you wrote down from the HTML in
FrontPage Express. Save the image with
the old one, but under a new name, such
as stonehengel_small.jpg. Under the
Save options, choose to save the image
as a progressive JPEG (see Jargon
Buster on page 23 of this book). Doing
this will enable the image to load faster
in your page to impress all who visit!
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_Setting up your own Web site on a Mac is a doddle if

H OW tO you've got Netscape Composer...

Use Netscape

here’s a great sense of achievement in building your
own Web site and it's not as difficult as it might appear

at first. Whether you're a Mac or PC user, there are
plenty of programs around to do a lot of the hard grafting for
you. On the next few pages we'll show Mac users how to create
great-looking Web pages with Netscape Composer. This simple
Web page creator comes free with the Netscape Communicator
package and can be installed from the cover CD of Internet
Advisor. For further information about the cover CD and
instructions on how to install the software, please refer to the
‘What's on the CD'" section of the magazine.

Netscape Composer

- To create quality Web pages with the Netscape
Composer software program you don't have to
use any programming code - it's similar to
using an up-to-date word processor. It's
easy to make the Web pages look more
professional too as there are icons which
you can click to change the fonts,
indentations, paragraphs, lists and headings.
There's even an integrated spell checker in
case spelling is not your strong point!

On the next few pages we will be showing
| you how to create a basic Web site in Netscape

@ Internet Advisor e Build your own Web site
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This tutorial is for

Apple Macintosh

users. If you have a

PC turn to page 6
or 32 (HTML)

Composer, with several linked pages. We'll also show you how to create
an email link so visitors to your Web site can send you their feedback.
Then we'll move on to fine-tuning your site by adding and sizing pictures

and creating links to them.
It's really not a difficult process. In fact, anyone can do it without
having to learn a new programming language or spending Software:

m large amounts of cash on expensive software programs. | Netscape

All you really need is your computer, a Web browser, the | Composer
software from an Internet Advisor CD, the ability Project:
to throw a few interesting sentences together Creating a Web
and, of course, our handy guide! Just follow page; creating

< < links; adding and
;= our step-by-step tutorial and your site

. . ) sizing pictures
" will be up and running in no time. Turn
the page if you're ready to begin...

Hyperlink every Web page. Your image which reduces the
A bridge between Web Web browser reads the file size for faster loading
pages. Clicking on a HTML and then presents of images.
hyperlink takes you to the page on your screen. GIF
another Web page. JPEG (Graphics Interchange
HTML (Joint Photographic Format) A file format for
(Hyper Text Markup Experts Group) A file saving images so they can
Language) This creates format with a compressed be seen by a Web browser.

Build your own Web site e Internet Advisor @
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o Uiew _Tavert

ST Toon Beskmanis T eniieen O 2 IT
Netscope Composer 11 oW :
E—a8

STEP To launch Composer in
/) your Apple Mac, start
1§ f up Navigator by

double-clicking on the
Navigator icon. Then go to the
Composer option in the
Communicator drop-down menu
at the top of the screen. A blank
page will open up which will be
your homepage (the first page of
your site that a visitor will see).

Above the blank page you will see

two toolbars with control buttons

along them. You can use these to
make adjustments to your Web
page as you put it together. E= I WL AL

STEP Type the title of your site
&) straight onto the blank

I CifNeTscope

#

L

£5 page. We've chosena f—— —= ;
site for John Smith, an John Smith s
amateur astronomer who has New planet site

discovered a planet. You can
adjust the size of the text by
highlighting it, clicking on the Font
Size tool (bottom tool bar, second
button along) and selecting the
size you want. You can also centre
the text by scrolling down the
Format menu to Align and then
Centre. Save your page as
index.htm as this is the standard
Internet name for a homepage. E= EE T
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E - Vrl: ot i:rl;w 1»!:7! Nlmﬂ‘ Tools Bookmerks Communicator - M,,,) :‘S;:xt::,?‘;\z‘s;l STFP Now youv” pl'Obab|‘/ want
%) some additional text to
} tell viewers what your site
inlat ] &
John Smith s _ is about. In the example
New planet site here, our astronomer wants to

publish his detailed findings of
dradek e the planet on the Internet. Key in
il e ek Soere ey 1| the descriptive details using text
in a smaller font size and check
for spelling mistakes. Now save
your file again. It pays to save it
each time you add something

) new or change anything
50, should anything go
wrong, you will always have
the latest version.

STEP If you want to change the

: /| colour of the text heading
- ; LUJ highlight it with your

John Smith's mouse and click on the

New planet site colour icon in the second toolbar.
A colour palette will come up.
Welcome to my Web sitel I'm John Smith, 8n smateur astronomer from London Select the colour you want and

| recently discovered 8 new planet in the region of Orion Although the results
of my indings have been docums
them in full on

e e el click OK. If you want to add a
horizontal line to separate the
heading from the descriptive text
make sure there's a space
between the heading and the text
and click on the Horizontal Bar
control button in the first toolbar.
You can see that your homepage
Tl is now beginning to take shape.
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STEP To expand your site you will
/=) need to create other pages
g/j and links to them. You can
make as many of these as

you want. To create another page go
to the File menu at the top of the
screen and select Blank Page. Using
the page that comes up, use Steps 1
to 4 to make another Web page.
Save your new page and name it
with one lower case word (adding
the suffix .htm) so that you can find
it again easily. The most important
page in John Smith's site is the one
with his astronomical findings.
We've saved it as planet.htm.

STEP Now create a link from your
homepage to the second

@ page. First make sure that
both pages are in the same

folder. Then open your first page and
select Edit Page from the File menu.
Key in some short text to describe
the second page and then highlight
that text. Choose Link from the
Insert menu. You will be asked what
you want to link the text to. Click on
Choose File, select the page you
want, and click on Open. Then save
your homepage again. Remember to

include links from other pages to the
homepage for ease of navigation.

K "!q

A new planet!!

Eartier this year | discovered anew pww( Inthe fegion of Orfon The results of my findings have been
1 wante: full on the Net S0 here they ore.

It 1} began on 8 crisp Febuary evening February 15th 1999, to be precise | was locking ot Betelgeuse, the
famous red giant star of Orion, when | noticed a tiny speck just beyond it to the right. AL first | thought my
telescope lens was dirty 30| cleaned it and had another 1ok But to my surprise the speck was still there |
made 3 note of this and went downstairs o have some tes Later that evening | had snother ook and wos
SUPPrISed to see that the speck seemed to be merging with Betelgeuse. Over the next couple of days |
realised that this was not the case but 1n fact the speck was moving sround the giant red sun

Excitedly, | charted the movement of the speck sround Betelgeuse until it disappeared arcund the left hand
10 of the s A couple of deys ater the speck.re-emeryed Lo the right of Beteloeuse snd procesded Lo
and the Royal Society and they
were lnvrvswd with my findings. In foct they named it after meit

The John Smith planet 5 about half the size of Earth and revolves oround Betelgeuse every three ond a hall
days At present nothing is known sbout the planet’s atmosphere, althouoh o rumber of Leams ore reputedly
working day and night Lo learmn more about it|

Tion 1133 om B3 7 T
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on 12 10pm 35 I

Weicod] |
Ireced |

cn
juits

New planet site

Welcome o my Web sitet m Job Smith, an amateur ast

I recently discovered a new planet in the region of Orion Although the results
of my findings heve been documented elsewhere | wanted Lo publish

them in full 0n the Net S0 here they are

'l-mﬂ:

$TEP If you want your visitors to
{ contact you, you need an
7 email link. Type your email
address at the bottom of
your homepage, then choose Insert
and then Link. Now, instead of
selecting another file, type in your
email address prefixed with
"mailto:". For example, we've typed
mailto;john.smith@rhubarbcrumble.
co.uk). Then save your homepage
once again. You can also create
links to another Web site here by
typing its full Web site address into
this space.

@)

P Now you've created a site

2 that works! Our example
(0 ) features ahomepage and a
Web page about an
astronomical discovery. We've also

created a page about the site’s
author and another page with a list
of his favourite astronomy sites.
These pages were made by
repeating the same procedures
used in Steps 5 and 6. The only
problem is that the site looks a bit
uninteresting without pictures,
coloured backgrounds and links to
other sites. Read on to find out
how to include these elements...

Build your own Web site e Internet Advisor @
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Mon2S3pm & 2 Pf

STEP To liven up your site you'll
{0 need some pictures. First

make sure your images
are in either in GIF or
JPEG format (see glossary on
page 23). You can prepare these
easily with a graphics program
such as Graphic Converter. First
select the place on your page
where you want the image to be
and choose Insert and then Image.
Then click on Choose File to select
the image you want and click on
OK. We've chosen a snazzy image
of space which was available free

[Chaase Fiie_
e Dot

ults |

Top wna Bettom 5

prests
ot Borter [T ptues

from www.graphics4free.com.

STEP You should now see your

picture in your

Civifale lA lAN

homepage. If you're
happy with the way it
looks, save the homepage. If you
can't see the image, check to see
if your graphic has the .gif (GIF) or
jpg (JPEG) suffix. If it doesn't,
make sure it does. You may want
to change the position of the
image. If so, go to the Format
menu, choose Align and choose
from Left, Centre or Right. If
you're not happy with the image,
see if you can dig out a better one. LI',J

John Smlth s
New planet site
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Mon 3:08 pm £ 2§

i epresratians (options]
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|
e

ot wrapied et view
I Nevigator windo.
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wel

my Web site! fm Joba Smith,

n amateur astronomer from London

scoversd anew planet in the region of Orion Although the results

I

Mon310om &5 B B]
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]

e target 1 specifed e {agtorad)

e targpts 10
T2 @ Correet P

[Exira Wi

STEP Are you happy with the
([ size of the picture? If not,
[/l you can easily adjust its
dimensions. To do this,
click once on the image to
highlight it and choose Image Info
from the Format menu at the top
of the page. You can change the
size of the image by adjusting the
height and width pixel
parameters shown in the box that
appears. Make sure that you
choose appropriate sizes, though,
because enlarging the picture
greatly can cause the image
to become distorted.

STEP As an extra touch you

) may want your homepage
image to take the viewer
straight to the site's most
important page. Well, guess what,
you can add links to images as well
as text! Highlight your image by
clicking on it then choose Link
from the Insert menu at the top of
the page. When a dialog box comes
up, click on Choose File to select
the page you want the image to be
linked to. Click Open and then OK.

We've linked John Smith's image to

Welcome to my Web sitel |

‘m John Smith, an smateur estror

rom London

I recently discovered anew planet in the region of Orion A

ough the results

his page about the new planet he's
discovered (planet.htm).

Build your own Web site @ Internet Advisor @



_@ Netscape Composer e Fine-tuning your Web site

$TEP |f you want to add
ﬂ@ pictures to any of
UfE

your other Web

pages, simply use

the same procedures described in
Steps 1to 4. In our example here
we've chosen a page about John
Smith where he goes into his
background and details about
how he first got into astronomy.
Photographs of real
people are always a plus €
point on Web sites as
they add that essential
human quality to the

S$TEP Look at your Web pages to
f? @ see how they can be
z» J improved. Is the text the
right size and colour? Are

the horizontal lines well spaced?
Try out a few coloured
backgrounds to see if they can
improve the look. Go to the Format
menu and select Page Properties.
In the Colours and Background tag
choose Use Custom Colours and
click on the Background square. A
colour chooser will come up with
which you can adjust the

background colour. Choose the
colour you want, then click on OK.

Mon 5 15 pm €31

feii o

" Lecven 4[:». /mw-.I». R0 e

B i R I e e L e

m— ]

John Smith

1 was born 18 London on 25th February 1942 During the wer my parents
emigrated to the United States and | was brought up in Fort Worth, Texas |
came back to London in my esrly twenties and I've lived here ever since.

1 first became nterested in astronomy when | watched Patrick Moore's TV
programme, The Sky At Night, during the '60s | bought myself 8 telescope
2nd 3 few books and found myself immediotely hooked by the subject. | find it
satistying knowing where we are in relation t6 the sun and other stars

Ireally began to get sericusly Into the subject during the mid 70s, when |

much larger telescope | found | was sble to see some of the more
exotic, distant things in the universe thot | had only read sbout in bocks |
decided that | would look for objects that hadn't been catalogues before -
stars, planets, comets, and just about anything else that's visible ina
reascnably powerful telescope.

BQ Eoriier this year | discovered a new planet in the region of Orion |
B immediately contacted NASA ond the Royal Astronomical Society and they
were imoressed with my findings In fact they nomed it after mel!

et 15 sbout half the size of Earth and revolyes around Betelgeuss every three and 3 half days. Nothing
sbout the planet’s atmosphere, sithough 3 number of teams are working on it!

RS MR WY A

e siien B
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John Smith

1 w83 borm in London on 25th February 1942 During the war my parents
emigrated to the United States ond | was brought up in Fort Worth, Texas |
came back to London in my early twenties and I've lived here ever since

first become interested n astronomy when | wakched Patric Hoore's TV
programme, The Sky At Night, during the 0 | bought mysell a telescope
and a few books Y the subject | find it
satistying knowing where we are in relaticn to the sun ond other stars.

1 really began o get seriously into the subject during the mid 705, when |
bought 8 much larger telescope. | found | was ble to See some of the more
‘exotic, distant things in the universe that | had only resd sbout 1n books. |

ided that | would ook for objects that hadn't been catalogues before -
stars, planets, comets, and just sbout anything else that's visible in &
reasonably powertul telescope

Earlier this year | discovered a new planet in the region of Ori

% oyel :e\y and they
® were impressed with my findings. in fact they named it after meit

The plsnet is about halt the size of Earth and revolves around Betelgeuse every these Bod s kel doya oty
13 known about the planet's stmosphere, although & rumber of teams are working on

4
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= _Tie (@il Uiew Insert Tormel Tools Bookmerks Communicator

STEP To make a page more

= colourful, try inserting
./ another image as a tiled

(repeated) background. In

the Format menu go to Page
Properties and click on the Image
button underneath where it says
Page Background. Click on Choose
File, select the image, click Open,
then OK. Your image should cover
the whole background. You may
need to change the colour of the
text on this page so it is more
readable. To do this highlight the
text, select Colour from the Format
menu, then choose the colour.

] T Nelscape Composer - lindexnimi - CUfiNelscope

.‘;]’a»"f:[ FOLE

M= m AAAR

o

STEP You've done it! Your very
B — own Web site is up and

John Smlth s
New planet site

Welcome to my Web sitet f'm John Smith, on amateur estronomer from London
1 recently discovered a new pianet in the region of Orion Althoudh the results

5 L U ) running and ready to
upload on to your Web

space on the Internet. Before you
do this, make sure your Web site
works perfectly. Open up your
homepage and click on the links
that should take you to the other
Web pages. Make sure that all of
the links work properly and that
you're happy with the overall look
and feel of your site. When you're
happy with everything turn to

o page 56 to find out how to upload

T

=21 your site onto the Web.
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Build a Web site on your PC or Mac with our

How to straightforward guide to HTML code..

Write in

o create a Web site you don't need to invest in any
T fancy software. You can use Notepad on your PC, or

SimpleText on an Apple Mac. Both programs are free

and should already be installed on your machine. To make a

Web site in this way, you'll be writing the HTML
code yourself. HTML stands for Hyper Text
Markup Language and is the code in which all
Web pages are written. Even if you use a
piece of software such as FrontPage, it still
works in HTML - it just places a user-
friendly graphical interface over the top so
that you don't need to see what's happening
under the bonnet. But it's a good idea to

learn a bit of HTML. That way, you can
tweak your Web site by simply opening the

Here's our featured BACKGROUND="pap23.gif

example in HMTL: 62

<HTML> <CENTER»

<HEAD» <H1>The completely useless
<TITLE>Welcome to my Web site/Hi>
homepage</TITLE> <IMG SRC="pencil.gif"
</HEAD> ¢/CENTER>

<BODY TEXT=black <BR><BR>

@ Internet Advisor e Build your own Web site
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HTML code

HTML document and adding or removing a few words.
HTML works by ‘marking up’ the text that you
want to display on your Web site. For example,
text that you want to appear in bold is marked
with <B> to indicate where the bold starts and
¢/B> to indicate where it ends. It's that
simple. Read the box below for
more examples of HMTL

code. On the next few pages
we'll show you how to create

a Web page in HTML with
links to other sites,
images and a colourful B
background. It's not as
difficult as it looks...

This quide to building
a Web site using
HTML code is for
both PC and Apple
Macintosh users

System:
HTML code

Project:

Creating a basic Web
site with links to
other Web sites,
inserting images and
background colours

Hello, and welcome to the great pages!
useless Web site. It won't <BR><BR>

be useless for much Here is <A

longer because it is going HREF="http://www.netadv
to have links to all of my isor.co.uk">Internet
favourite places on the Advisor</A>

Internet. Click some of the  <BR>
links below to go to some And here is <A

.co.uk"sDisney</A>

HREF="http://www.disney

<BR><BR><BR>

<A
HREF="Mailto:me@myisp.
com">Send me email</A>
</BODY>

</HTML>
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_@ HTML e Creating a Web site

STEP Open Notepad on your PC
f from the Start menu. Go
L J to Start, then Run. Type
the word Notepad into

the Open box and click OK. Mac
users open Simple Text. You'll see
a white window open on your
screen. This program is similar to
a very basic word processor,
which is fine as we're not going to
be doing any heavy duty
programming - we're just going to
mark up some text so that it can
be displayed as a Web page.

STEP HTML has two types of tags:
¢ ) start tags and end tags. All
L/_f HTML tags are placed inside
angled brackets. So, to start

an HTML document, use <HTML>
and to end it, use ¢</HTML. The rest
of your code goes between these
two tags. To start your Web page,
the first thing you need to type is
<HTML>. Now press return a few
times to put some blank lines in the
document and then type ¢/HTML>.
You'll enter the rest of your code in
the blank lines between these tags.

1 Untitied - Notepad
fle E& Seach Hep

[=1a[X]

 Untitled - Notepad
fle Bt Seach Heép

P

[<HTHL>

[</HTHL>
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B Untitled - Notepad
Fla Eot Sexch Hep

=10 x]

[CHTML>
CHEAD>
<TITLE>Welcone to my honepage</TITLE>
</HEAD>

</HTHL>

fde. Ede Seach Heb

HTHLY
HEAD>
TITLE>DWelcone to ny honepage</TITLE>
/HEAD>
BODY>

/BODY>
JHTHL|

=

o

Creating a Web site o HTMLQ_

STEP Now you need to write the

&) header information. This is
5 ) where you can choose

~ what should be displayed

in the Web browser's title window
when a visitor views your Web
page. Under the <HTML> tag type
<HEAD> and hit the return key.
Then type <TITLE>Welcome to my
homepage¢/TITLE> on the next
line. Now hit the return key
again and type </HEAD> to
indicate that you're ending
the header information.

STEP Next comes the body of

| your page - the area in
dl
-/ which you enter your text,
Web links and images. This
area starts with <BODY> and ends
with a </BODY> tag right before
the final closing </HTML> tag. So,
under the </HEAD> tag, enter a
<BODY> tag, and above the
¢/HTML> tag, enter a tag like so:
</BODY>. Make a few blank lines
in the middle so that you've got
somewhere to type your text for
the 'body’ of the page.

Build your own Web site e Internet Advisor @
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STEP Now you can enter anything  [FRIEEEIEEET — BEE
— s ’ fle ER Seach Hep %
& you like in those blank lines. [Gis 3
5 H i [<HEAD>
C/,/ Levs Start W'th a headlme' <TITLE>Welcone to my homepage</TITLE>

which will be set at its  [$/nee>>
biqqest size: H1. First, type the  [c#1>The completely useless Web site</H1|
opening tag <H1> and then enter
some text straight after it. Insert
o </BODY>
your closing tag at the end: </HD>. [czurm>
You should have something like
<H1>The completely useless Web
site</H1> under the <BODY> tag
now. For a smaller headline,
increase the number after the H,
for example: <H2> or <H3>. (B8

STEP It's a good idea to save
V<4 your work now. From
‘@ the File menu at the top

of your screen, select

Save and then name your
document, ending with the .htm file
extension. This file extension tells
your browser that it's looking at an
HTML document when you load it
up in Step 7. For the first page of a
Web site, index.htm is the usual
convention. To make it easy to find A .
the file later, you may want to save 53"9 5‘3‘5{93- lTexl Documents
it directly onto your desktop. e :

E: My Computer
Network Neighborhood
html grabs

@ Internet Advisor e Build your own Web site



Microsoft Internet Explorer

s & 4

My Computer
=5 Network Neighbothood
1 bt grabs

0] c:\wwcowsmssmommamm

The completely useless Web site

Creating a Web site HTML@_

$TEP To look at your work,
C ) open your browser, and

Z, " select Open from the File

menu. Either Netscape or

Internet Explorer will be fine, and

you don't need to be online for

this as you'll be viewing the page

that is stored on your hard drive.

Find the index.htm file in your

Open menu and then click Open.

If you can't see the file, click the

Browse button and then find it ¥

on your desktop (or wherever

you saved it to).

STEP And here is your first
/(_V‘ HTML creation. It may
(2 not look like much, but

you can go back into the
document and add colours, links
to other sites, pictures, and
more. All you need to know are
the relevant HTML tags to add
to your document. Even better,
the whole thing takes literally
just a few minutes to produce.
Keep hold of your HTML
document, and turn the page to
change the colours.
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S$TEP As long as you didn't

0 accidentally delete

your HTML

document, you

should now have a short text file
which should look something like
the one we have shown on the
right here. If not, don't worry.
Type in the text, exactly as shown
in the picture on the right, into
either Notepad on your PC, or
SimpleText if you have an

Apple Macintosh.

STEP First, we're going to
Q@ adjust the
\J/  properties of the

page. We can

change the background colour of
the page, as well as the colour of
the text, by modifying the <BODY>
tag. In your text document, place
your cursor after the Y of the
BODY and type one space.

Now add BGCOLOR=RED
TEXT=WHITE. The full tag should
now be: <BODY BGCOLOR=RED
TEXT=WHITE>. Open the
document in your browser.

0 Index - Notepad .15
o £3 Sesch oo
HTML
[CHEADY
KTITLE)Velcome to my homepage</TITLE>
HERD>
<BODY>
(H1>The completely useless Veb sitec/H1>
</BODY>
[</HTML>
L JJ

33 Welcome 1o y homepage - MicrotoftIntcimet Explores provided by Vo Net

i{hﬁ?wnmn@pm\!ﬁmx_ y
Lk ] Ol Uk @] Froe ool € VWi

The completely useless Web site
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Welcome to my homepoge - Miciosoft Iteinet | sphoves provided by Vigin Net

STEP In the previous step, you

Fle £ Vew Favodes Jodk bHeo
SRS ey A e e |[ | saw how to change the
b (B e T Yy W P T 5 o G 0 background colour and
ks )0akmes ks EFstomal @)Wt ; text colour. Web browsers
The completely useless Web site 7| recognise a number of dlffere'nt
colours, so you can try changing
them in your text document.
Other colour tags to experiment
with include RED, PURPLE,
GREEN, YELLOW,
2 o BLACK and
ORANGE. Try
u changing the colours
yourself and decide
on one you prefer.
- A N
a% 3
o
Gy o) STEP Reverting to our white
E;EEE;*I"- to my homepage</TITLEY 0?) text with a red
E:‘.‘?hi‘f;".:!:!i‘l,'iil;:i'.‘.i. stecon> ' /4 background <BODY
T S i
ittt il Rt L I T o TEXT=WHITE> we now want to
T add some more text under the
S headline. Under the headline
(marked with <H1> tags) type <BR>
twice. <BR> stands for line break,
so whatever you type next will be
a couple of lines lower. Hit return
and type a line or two of text
_| about yourself. End with another
a o ®r tag for a line break.
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STEP Save your text document,
U and then open it in your
Web browser (from the

Open menu, or you can

simply click on the Refresh
button if the document is already
in view in your Web browser's
window). You will see something
looking like the page shown on
the right. Now we are ready to
add some links to the other

Web pages.

STEP |In your text document,

0 @ under the final <BR>
7 tag, press return a
few times to create

some space in which to type.
Notice that returns don't actually
affect the way the Web page
displays, you must designate a
line break with the <BR> tag.
Under that <BR> tag type:

Here is <A HREF="http://
www.netadvisor.co.uk™>

Internet Advisor</A>.

g 1o Have krks 1o all of

<HERD>
CTITLE W icone: to-my: Nomepage</TITLE

Boby 8ccoLoR-Reo TexT-witT

ChidThe conpletely useless o sitecsu

<BR> e

el10, and velcone to the useless Ueb site

It won't be useless for nuch longer because it is goi

to have 1inks to all of ny favourite places on the Internet.
Click some of the 1inks belov to go to some great pagest

<BR> <BR)

Here is <R WREF="Nttp://ww.netadvisor.co.uk™>Internet AGuisor</A>

</800%>
</HTIL>
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Improving your site e HTML .

STEP When you open the
o] [ = document in your Web
ch’/ browser, you will see
that there is an active
link in your Web page. Clicking
this underlined link will take the
viewer to the Web page that you
have specified (in this
case, it is the Internet &
Advisor homepage). g
You'llneedtobe (@
connected to —
the Internet
to test this
yourself.

STEP After
() "2 the link, type a <BR> tag
UC’J/ to insert a line break,
and then repeat the step

for another Web site. For
example, we have added:
And here is <A
HREF="http://www.disney.co.uk">
Disney</A> to provide a link to the
Disney UK Web site. Again, finish
with a <BR> tag and keep adding
as many links as you like.
Remember to save your work.

Build your own Web site e Internet Advisor @
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(@) HTML o Adding graphics '

STEP To start with, open your Backgrounds
/ Web browser and head
[ ?7 for http://www.ree- e e
graphics.com to grab a SR i1 i aiabiat
free background for your Web 1900's of FRER CLEART MAGES -JustA Mouse Cack Amed
page. There are plenty of coonod oyl -pocand

backgrounds to choose from so M‘,,._::,:,,,,,m—:;,_ ecrgmmes Ve o

just browse through them and B =
download one you like by - -
right-clicking the image, choosing
Save As and saving it to the same
folder that your HTML document
is in. Apple Mac users should click
on the image, hold and wait for
the menu to appear.

STEP Now open your HTML  [555 s e

{ ° document in either |3y
) Notepad or  fcuese>

SimpleText and  [eor rext-siack sacxsaoma-papzs.gief
adjust the line that says BODY [Gmae = "2 weies= e st/
BGCOLOR=RED TEXT=WHITE>. [t wa't be sseless for mch Yenger because it 15 going
The replacement line should be  [Gasea™ ™ Hisks betew to gu to sone great pagest
changed to include the name of - sere 15 <& scr-neep:/rvmm.aetasuiser co.ui > aternet aowiser<ss>
the background image file = iN QUM  |uy nere 55 <o mer-ntep://wwe.aisoey.co.u-spisneycras
case, it is pap23.qif - and the new ,‘:n
text colour you want. So our >
BODY tag now reads:
<BODY TEXT=black
BACKGROUND="pap23.gif'">.

> e
(4
©
- |
TITLE Velcone to my homepage</TITLE>
elle, and welcome to the wseless Vb site.
to have lisks to all of my Fawourite places on the Iatermet.
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The completely useless Web site

Hello, 3nd welcome to the useless Web stz It won't be useless for much longer because 2 i going t have Inks to all of
muy favourte places o the Intermet. Click some of the ks below 10 g6 to scene great pages!

Here i Jut
Andberess [

R e SR D N2

:.,
i
H

Adding graphics e HTML .

STEP On the left you can see
[)(0)) the result of that little
|2/ code tweak when viewed

in a Web browser's
window. We've also centred the
page title for extra neatness. For
this, add a <CENTER> tag (US
spelling again) on the line before
<HD>The completely useless Web
site</H1> and then a closing
¢/CENTER> tag on the line that
follows. Now you can think about
adding another image to your
Web page. Proceed to Step 20
to find out how...

S$TEP How about adding a
%} centred picture under

L the page title? In
~ " order to do this you
either need to have a scanned
photo of yourself, a graphic which
you have made yourself, or one
that you have downloaded from
the Internet. You will find plenty
of free clip-art to download at:
http://matrixvault.com/PW.
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_@ HTML e Adding graphics

STEP To add the image to your
(7’),\ fWeb page, include the
(45 following line wherever

you want the image to

appear on your Web page: <IMG
SRC="pencil.qif"> but remember
to change the name of the image
for the one that you have
downloaded or it won't work.
Your text file should now look

something like the one we have
shown on the right.

STEP Return to your Web

o) browser window
J z and open the
HTML document

once more. Now you can see the
image in the place you have
chosen to put it. You can do this
as many times as you like and
-with as many different images as
you like, but try to keep the

page relatively uncluttered or it
will look very unprofessional.

<HEAD>
KTITLE>Velcone to my honepage</TITLE>
</HERD>

<B0DY TEXT=black BACKGROUND="pap23.gif">

<CENTER)
cHi>The conpletely useless Ved site</K1>

cims sacevpencil.gif>
[C/CENTER

<BR><BR>

Wello, and welcone to the useless Wed site.

It won't be useless for much longer because it is going

to have links to all of my Favourite places on the Internet.
Click some of the links below to go to some great pagest
<BR> <OR>

Here 45 <A HREF="http://wwm. Lco.uk™ Inte
<8R>

[an here is <A HREF="http://ww.disney.co.uk”>Disney</a:
<8R>

</800%>
</HTHLY,

o

¥ Welcome o my bomepage - Nelscape
o ERI N S Prownioor Ho =

3 ¥ a N a e
| Bak o) Reost  Fome  Sewch. Nel Pt Secaty
IE ks S Lipster e /OATNOOWS DESKOP/ =
The completely useless Web site

HeRo, and welcome to the useless Web site It won't be useless for rmuch longer because 2 is going to have knks to all of
my Exvourite places on the Intemet. Click some of the ks below 1o go 1o some preat pages!

W A2 RN
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Adding graphics .HTML@_

O] @TEP Finally, let's add a line

(CHTHL>
<HEAD)
<TITLE>Velcome to my homepage</THTLE>
[</HERD>

<BODY TEXT-black BACKGROUND="pap23.gif">

CCENTER)
<H1>The completely useless Veb sitec/H1>

<IMG SRC-"pencil.gif™>
</CENTER>

<oR><BR>

Hello, and welcone to the useless Veb site.

It won't be useless for nuch longer Secause it is going

to have links ta a1l of ny Favourite places on the Internet.
Click some of the links below to go to sone great pagest
<BR><BR>

Here is <A NREF="http://wuw.netadvisor.co.uk™>Internet Advisor</R>
<8R>

And here {5 <A HREF="http://www.disney.co.uk">Disney</a>

<BR><BR) CBR>

<A HREF="Mailto:ne@nyisp.con”>Send ne email</n>

</800%>
<IHTHOY

L

¢/ \//f‘ of text to the end of
V4 J the page so that
visitors can contact
you. This is a piece of HTML
known as a ‘mailto’ tag. After
your list of links add a couple
more line breaks, and then the
following: <A
HREF="Mailto:me@myisp.com">
Send me email</A>
remembering to
enter your own
email address.

STEP And that's it. You now
/} W have a simple, but

[ " Soonas & Locaton e/ 77WRO0WS OESKTOP o saga/ea i

-7 good-looking Web
page. Play around

The completely useless Web site
w - S

i favourte places on the Tntermet. Chck sorme of the baks below to go to some great pages!

Here is ot
And bere

Hello, and welcome to the useless Web ste. It won't be useless for muich longer because 2 is gomg to kave Enks to all of

B B VA AR T R

with the code yourself, adding
more links to your favourite sites,
changing the background images,
colour and so on until you're
happy with the final result. Then
turn to page 56 to find out how
to load the Web site onto your
Web space on your Internet
Service Provider's server for all
the world to see.
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@ Introduction to Web graphics

In this section we show you how to make different types

H OW tO of graphic files to enhance your Web site...

Create Web

hen browsing through Web sites you won't notice
w whether you're looking at a GIF or a JPEG graphic.

You don't need to. But when you build your own site,
the difference between the two becomes quite important.

First, a Web graphic hinges on quality versus speed. Do
you want a graphic to look exactly like you made it or do you
want people to download it faster through their browsers? In
reality, the choice is likely to involve a combination of the two. It

(Joint Photographic Experts Group) A file format
with a compressed image which reduces the
file size for faster loading of images.

GIF
(Graphics Interchange Format) A file
format for saving images so that
they can be seen by a Web browser.

Websafe palette

The 216 colours that can be displayed by
both Mac and PC operating systems.
You can then guarantee what colour
your site's visitors will see on-screen.
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Introduction to Web graphics @

This quide is for PC

®
and Mac users. PC
users, turn to page
48 and Mac users

turn to page 52

is always important to remember that whichever format you use, it has
to be small in file size so that the viewer can download your image in
the shortest amount of time without the quality being too distorted.

Basically, a good quality graphic will take longer to download on to
your screen. Therefore, you need to use a format that keeps the file size Software:
small (making it faster to download) but also shows it in the best quality. Paint Shop Pro 5
The graphic formats that can do this are GIF and JPEG. GraphicConverter

A GIF only contains 256 colours (a colour palette) of which 216 are Project:

‘Websafe' because the Windows and Mac palette only have 216 - Creating GIF and
identical colours. Because of this limited palette, a GIF format is JPEG graphic files
best used for logos, buttons and flat colour graphics. for PC and

A JPEG is capable of storing millions of colours and so is Apple
best suited for photos or images with lots of tonal p\ecost
or colour gradation. This format uses a
compression which can cause
distortion, though it is not usually
clearly visible.

JPEG is best used for
large photographic images,
while GIF works best for small
images or images that have
large areas of flat colour. So,
the simple rule (though it
doesn't always apply) is: use GIFs
for logos and JPEGs for pictures.
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_@gaphics o Creating a GIF ona PC

STEP First start up your graphics
n software program, in this
U case, we are using Paint
Shop Pro 5. Go to the File

menu, select Open and find your
icon or button on your hard drive.

STEP Now load in the ‘Websafe'
@B colour palette: go to
L/j Colours and then load
palette (Shift+0). Find
the file called ‘safety.pal’ in the
palettes folder.
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Creating a GIF on a PC e Graphics @_

STEP Under the Colours drop-down menu
@ you can Edit Palette or check the
./ number of colours in the image if
you select Count Colours Used.

STEP Then go to File and
/.| Save As. Here you
7 need to make sure
that the file format is
‘GIF". Keep the name simple
and in lower case characters
add .qif at the end.
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STEP Open a suitable

I image (like a
U photo) within
your graphics

program. Here we've |
chosen an image from @
the second issue of
our magazine.

[Fefame: . c\iedowDesop\PEGipg |
) N JFEG -JFIF Corglent ¢

STEP Selecting Image Information
&) (Shift#)), you can see that

& this image is made up of
millions of colours - that's

the bit next to Pixel Depth/Colours.
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Save p I {\ﬂ Desklo»p-)”

Creating a JPEG on a PC e Graphics Q_

STEP Now goto Save

delslmm | 9

As and select

=) My Computer

25 Network Neighbothood
Issue 3 grabs old

2 walkthrough

JPEG

JPEG from the
file format
option. Before you click
on the Save button, click
on the Options button to
adjust the compression.

File name: lpholo ind
‘Save astype: [JPEG - JFIF Complient (pg~ifipeg) ]

—

Save Oplions

STEP Try a selection of

[ ] oo | s |

I . [ = @\ compression levels
‘ 7 i = S ~ (90, 80 or 60)
L edmendn & 3= = v until you're ha
€ Brogoss AR 7 ‘ : y PPy
= = = = with the results. Save them
. Compesson . [55 as different names and
f l-.1n---n-\nx-’;~|:nn\l { thenopenthemto
g o TR
v Gl Mo R compare results.
best qualty  lowest quality

_—

Save s type: !JPEGJFIF Compllant[‘.i?g;‘lxl;‘.ipeg] :J 3 Cancel l

Heb I
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‘ Graphics e Creating a GIF on a Mac

STEP First, start up Graphic
[ Converter. Choose
[ j Preferences from the
Edit menu (Command

+;). In the Preferences window

click on the Save and General | A B % BT
tabs and then untick the Add NG
Resourcesfork box. This will G i
prevent GraphicConverter from = Dest.fie format
adding a thumbnail icon and : ek
preview image to the GIF file, Danstnion Sl
which would add considerably to oo OciutResource
its file size. Click on OK
to save the setting.

STEP From the Picture menu
é select Colours, then
/:> Change Bit Depth
Dynamically

(Command + Control + 0). Use
the Maximum Number of Colours
slider to reduce the number of
colours used in the image to as

few as possible without
compromising its quality. Then

click on OK to convert your | Mimum number o colars (2-256) | oo |
image to the new, more efficient v 1 <
CO‘OUT palette. I Z oo S GZ 5B UR G SSENCIs@INcEosssREcAs N

) 3 |
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Creating a GIF on a Mac oGraphics.

TR T PICOime THRCl SpRcal Winawe Weip

STEP |f you want your image to
%\} have transparent areas
) that will show through
the Web page's
background double-click on the
magic wand in the tool palette.
Tick the Make Colour Transparent
box and then in the image
window click on the colour that
you would like to be transparent.
Click on OK to accept

Selected Color.

tndex

STEP Now choose Save As
/. | from the File menu
7 (Command + Shift + S).
Select GIF from the
Format pop-up menu and click on
the Options button. If your GIF
has transparency select the 89a
version, otherwise choose 87a.
Choose between normal and
interlaced drawing modes and
then click on the OK button.
Finally, save your GIF.
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‘ Graphics e Creating a JPEG on a Mac

S$TEP Start up Graphic Converter.
[ Scanned images may have
| dimensions or a resolution

too high for use in a Web
page. Select Size then Scale from
the Picture menu (Command +
Option +Y). Tick the Keep
Proportions box. Then set the
X- and Y-resolutions to 72
pixels/inch and the dimensions to
a maximum of AT
640 x 480 ‘a\/
pixels. Click
on OK to
continue.

| X-Resolution
Y-Resolution

STEP From the Edit menu

choose Preferences
(Command +;). In

ol
o
L]

the Preferences
window click on the Save and
General tabs and make sure the

Add Resourcesfork box is not

Dest. File Format
® format of Picture

ticked. This stops
GraphicConverter from adding a
‘thumbnail icon and preview image
to the JPEG file. Click the OK
button to save this setting.

O LastFormat

Color Table
O pitt Resource
O ctut Resource
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Creating a JPEG on a Mac oGraphics.

STEP Select Save As from the

File menu (Command +

Shift + S). Choose the

JPEG/JFIF format and
click on the Options button,
Choose the JPEG 6.0 Library
and tick the Progressive box.
Then tick the Preview box and
use the Quality slider to select
the lowest setting where the
preview is still of an acceptable
quality (generally around 80%).
Click OK.

4 Catculate File Size
originalSize 1208
New Size 43008

(0 Compress with Stumt
Chmprescion | Betier

|
[ Create LOWSRC

$TEP Tick the Create LOWSRC
Gl box if you want to use the
7 LOWSRC image tag in
your Web page so
browsers will load a low quality
preview of the your image before
the JPEG. This will cause a 16
greys GIF version of the image to
be saved with the JPEG. Many
Web designers don't bother using
previews. Now save your JPEG.

Name: [fairgroundwheel PG g

| formet =l
~ [ Compress with Stumt

| oeatetowsc Compresvion [Better 3

o Ceen) G |
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@ Introduction to publishing your Web site

t Now you've built your own site, it's time to transfer it on to
IRUGIBEOH e hiet. we show you how with CuteF TP and Transmit..

Publish your

nce you have created your Web site, you need to
o upload it to the Web space on your Internet Service
Provider’s servers. In order to do this, you
will need to use a File Transfer Protocol (FTP) program. FTP is
simply a method of transferring files from your computer to a
remote computer, i.. that of your Internet Service Provider.
Only a few years ago the only way to transfer files via FTP was
to use a text-based code and you had to know all the various
commands. Thankfully, technology has moved on considerably
and now the best FTP clients are those that act in a similar way
to Windows Explorer. We are going to show you how to upload
your Web site with two software programs: CuteF TP for PC
users and Transmit for Mac users.

CuteFTP

CuteFTP is a straightforward program as it uses a
graphical interface (i.e. you'll see graphics on your
screen instead of text) and has a host of features
such as drag and drop and batch upload. Using
CuteFTP to upload your Web pages should be a
painless and simple task, enabling you to get your
Web site up and running in no time at all. CuteF TP
comes in the form of shareware i.e. you have 30
days to try it and see if you like it. If you do, then you
Ineed to register it, otherwise you can try a different
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This guide is for PC
and Mac users. PC
users, turn to page
58 and Mac users
turn to page 62

software program. However, once you've
seen how easy it is to use, you probably
won't want to use any other program. Turn the page
to find out just how easy it is...

Transmit Software:
: ; . CuteFTP
Mac users can turn to page 62 for our guide to Transmit - a file T
transferring software for Mac users. Like CuteF TP, Transmit is modern, :
straightforward and easy to use with drag and drop features. Use it to Pro;ect.:
load your h to your ISP" d to download soft Uploading; end
upload your homepage to your ISP's server and to download software updating your

from FTP Web sites such as ftp.apple.com. Web site

Jargon Buster,

File Transfer Protocol (FTP) Upload

FTP is a fast way of uploading When you upload data on to the
and downloading files to and from  Internet you transfer it from your
the Internet. computer on to the Internet.

Server Interface

A computer that The interface of the software is

@ provides information to the part which is displayed, often
& other computers and graphically, thus allowing you to

which remains online communicate with the program

permanently. and give it commands.
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STEP The first time you start
(7 up CuteFTP you will
[

© [} Anorymons FTP Sites
) Perzondl FTP Sites

see this screen. This is

the site directory

where you can add and store
your favourite sites, including
your Web space address. If you
look in the Anonymous sites
directory, you will find a list of
popular FTP sites already
configured for you, from
Macintosh to Bob Dylan Lyrics.
Connecting to a site is a simple

Cick on “lmport™ to mport your old stes
Cick on "Personal Sitex™ to get started

matter of double-clicking

on a site name.

STEP The first thing you need to
/> do is add the address of Genera | A |

/ 5 your personal FTP space

e Ste Label

on your ISP's computers.

[Myweb S2e

This is where you will upload your
Hoc! Address

Web pages to, from which they can
be viewed online. You will need to
find out your personal FTP
address from your ISP, but this
information can usually be found
on their Web site. For example on
Freeserve, the address is:
uploads.webspace.freeserve.net.

| & Nomal

Ivebwaxlrm,wuk

UserID Password Remote Directory Filter

lkﬁmcmk |"“" M Local Fiteing
i Logntype —— ~ Transter lype WI—M i J
i -
* AutoDetect | I

Host T
[AutoDetect =
Initial Remote Directory

The login and password are the
same as you use for your email.
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Using Cute FTP e Publishing your site@

STEP The first thing to
&) understand with CuteF TP is

226-Transler complete.
226 Quotas on: using 12339 of 20000000 bytes
97 bytes Ok

STATUS>  Recelved |

STATUS)  Time: 0:00;01. Efficiency: 0.19 KBytes/s (197 bytes/s)
[STATUS:> Dene.

C: ~[cAweb pages =] Jpublic_ttmt
e

I Groysrea$ | Jimages
= index b
[Zimobies uk Imobies css
e Whizzy

| I Twodark

DusersFADM

Locd Tsae I T Romcte.

General lAd\f&m:edI E‘-:splay] Prcm:t:] Fuewa].’]

Mail Address (TG
Default Download Diractory IE.\.dcwn!oad _I
Teut Files Viewer |no!epad exe

HTML Editor
Log File
Max safe index size ﬁU— Kbytes
Default Belry ED_ Relry Delay |20

Start lSi!e Manager ¥ I

IV LogFTP commands ¥ Autosave view settings
[V Log server tesponses [V Show directory messages
™ Log ransfers to file IV Show login messages

[V Autodoadindexfiles T Resolve finks

¥ Monitor Clipboard

L b i A T S S
|

(&

) that there are two main

" sections of the window,

(or panes) that you use. The pane
on the left-hand side represents
your computer, and the one on the
right-hand side is the remote
computer. If you are connected to
your Internet Service Provider,
anything you see on the right-hand
side corresponds to your Web space
and you can browse it in the same
way as you would with your own
\hard drive on your computer.

P Befdre we actually

@ start uploading our
- Web pages, however, it
might be convenient to
change some of the settings. If
you are mainly going to be
using CuteFTP to maintain your
Web site, it is a good idea to
make CuteFTP's starting
directory the same as the one
holding your files. Click on the
File menu and choose Settings,
and in the Default Download
Directory box enter the path to
your Web pages e.g. c:\web

pages. You can also change the

Eancel

I appearance and toolbar

buttons if you wish.
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@ Publishing your site e Using Cute FTP

SYEP The uploading process in
CuteFTP is a piece of ) Q e
cake, involving a simple i [b— —b 1e%x 330
i 226-Transfer complete.
drag and drop operation. 226 Quotas on: using 12339 of 20000000 bytes
Make sure that you are connected [STATUS:>  Received 197 bytes Ok.

" STATUS®  Time: 0:00:01, Efficiency: 0.19 KB 197 bytes
to your ISP, select the files you [s1atuss  pone. R MR IAT yteRle)

want from your computer by M
clicking and drawing a box around =ljetweb pagesigreyareas fpubliczhiml

5 f v B150. 1 data htm
the files in the left-hand window, _,guss.book j7$2 ,;Zg Confim 4|
and dragging them across. As with  |=Jimages 018110jpg c
. ‘ TJodometerpagel 38110 lefthim \) Upload 3 selected fiels]?
Internet Explorer, if there is more |10 jetthim F38110_mainhtm
than one file, you will see a + sign |-J€100_mainhtm L38110_top htm 3
Y Sig 716100 top.htm Dechtm (Ec (|
next to the mouse. You will be |7 51a0faqd B ewards.htm
asked to confirm that you want to J:}?g“ﬂks-h‘m Obeckground2jpg  listhtm
. . 0, J I covershtm [Jlogo.git
upload the files, click Yes. Lo 2c2 ! R

STEP Once you've uploaded [
@& your Web pages for
(O)  thefirst time, it's a
good idea to go to pgesimobiles u

your Web site address to make
sure that there are no missing
files. As you make changes to
your Web site you will need to
upload the new versions of ke
your Web pages. You don't
need to delete the old files on
your Web space, simply drag
the new files across. If
CuteFTP detects a file with the same name as the one you are
draqgging across, it will ask you if you want to over-write it.

El
Type setto |

| T

Fie already exists. Overwite?

gvewite | Gewie | Bensme | B

1 Spe {
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v||ciiweb pages

|_IHippojem
|_imobiles u
[IMr Whizzy  Yew
|1 Twodark Epecite
JusersFAQ Change daectory...
Delete
Repame..,

v Sho

Looal =

Long ksting

File datails »
Sorting S
Refresh

Using Cute FTP e Publishing your site @_

f STEP To save you switching from CuteFTP
) toInternet Explorer and back again,

( you will find that you can use the

~ right-click menus on the mouse.
These menus work in both windows, so you
can create new directories, delete and
rename files and directories, view files,
change your viewing preferences and
perform an upload or
download operation.
These menu items
are also duplicated
along the toolbar, so
choose the method that
/ suits you best.

STEP The Resume

'i {/public_html

13
limages

[59 5n d s b

File akeady exists. Overwrite?

Select action ' x]

2 featureis very

(2 handy in CuteFTP,
providing your

Internet Service Provider
supports it. This means
that if you are uploading
alarge file and the
transfer is aborted for
some reason, CuteF TP
l can pick up where it left

[ size I [ Remote

off when you try

uploading it again, instead

of starting all over again. This saves your phone bill from taking too
much of a battering! As you can see, using CuteFTP is very easy, but
if all else fails, have a look at the help menu as it's pretty good.
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STEP Transmit is easy to use
[1 and can transfer files

{ / from your Apple Mac

- on to the available
Web space on your ISP's FTP
servers. When you launch
Transmit from the CD a window
will open which is split into two
sections, or ‘panes'’. The left-
hand pane shows 'your stuff
i.e. the contents of the Desktop
of your Mac. The right-hand
pane is ‘their stuff’ which
remains blank for you to add
details of your Web space. {*

STEP Now you may need to
() seek support from
gj your ISP as you need

to enter the address

of the FTP server that will store
your files. The username and
password is often the same as
those you use to access your
email account, but it does vary
among ISPs. The directory can
usually be left blank as the
server should direct you to your
personal Web space. When you

have checked that all the details
are correct, press Connect.
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STEP In the right-hand
&) pane you will see the
é > ) folder on the server
that your files need
to be transferred to. Use the
left-hand pane to navigate to
the location on your hard
disk where you have stored
your Web site. Navigating
through your hard disk in
Transmit is very similar to
the Mac's OS (operating
system) simply double-
clicking on a folder or hard
disk will show its contents.

$TEP Now you can copy the

/7 entire site from your
CJJ hard disk to your

ISP's servers. Choose

Select All from the Edit
menu. Now click and hold the
mouse over the files in *Your
stuff' and drag and drop
them into ‘Their stuff'. To
move individual files or
folders, drag them one by
one across to ‘Their stuff'.
This may be useful if there
are some files that you don't
want to put online yet.
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STEP Once you have made [Fiim e membersaolcom - oo i BB
/= changes to your site (S mywebsite 2] &)
&/ on your hard disk :1 tos Lo
you need to COPY | |cg imses
those new and edited files back % e = Please Logln to a Server LS
to your Web space. First, launch | |& s | ——
Transmit from the CD. In the left- | < T ::_]:
hand pane of the window, where oewory: [ ]
it shows you the contents of the i )
Desktop of your Mac, navigate
through your hard disk to find $
the directory which contains Your:elutt {nsieatiss
your site and openit so that |, ., wiurmeten A—
you can see its contents. =
STEP Again, logontothe [ X members a0lcom
. 2 myholiday

;= server by filling in

(O)  the details in the =il T
right.hand pane. i ?:::-::1 Nl ::: i : :::::;1:? ::
Drag and drop the files you england hml 1*| | ] fm bl 3¢
want to replace from “Your || |: Ll e 8
stuff' on the left-hand pane [} |7 rervardqic 1] | {31 inersst 22
R E R |
to ‘Their stuff’ on the right. | |~ ®™"™ | i i rw:m;mmm?l ::
G { images. ! scotiand. it |
If the file you want to [} |- iseresta et 22¢| | | =] viewsunl ok
replace is in a folder, 3 '“""h:"?' - -
o 72} mep.htmi Afile exists named fm.html
naVIgate to the same =] myphatss.btmi & What should be done with the file you're uploading?
folders on both "Your stuff' S e bt
” . . o (T3 Do this for all other duplicstes
§nd Their stuff’. Transmit e (o Gnae)
will warn you when you are Show Mare Informatian m——

about to over-write a file. — —
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Y 3 Wi Pihase_Teis - $TEP If you have made a lot of

/ members.aol.com 1/

7* changes to your Web site in

New Folder...
Get Info

Change Path...

Decode M
Encode As
ASCl Mode

Cancel

Move Items To...

Send FTP Command...

Aud PanTs Favories. - called Synchronize which ensures

one go it can be very time-
consuming to update files
individually. Transmit has a feature

that your files online are the same
as those on your hard disk. With
Transmit open, go to your Web sites
folder in "Your Stuff' and log on to

2] myptoten ptmi ®
B ] 12¢ [

P Shew More Iaformation

1Y B s e "
(2] | & et “55 Il your Web space in ‘Their stuff’. To
T, st

update all the files, go to the File
menu and select Synchronize.

STEP The Synchronize
S f? menu will ask if you
E: . (») want to update the
‘) Backgif Choose a synchronization method — = 2
=1 eatingout Ml O Update site (i.e. copy new
england html Update older files with newer files, h13 and Chanqed ﬁles Onto It) or
) Exitgif ® Mirror ax ey
R Update older files with newer files and dalete all others. ,mlrror (make an exaCt COPY
5 :(,r:r:' Choose o synchronization direction 27: or mirror image of the site,
i ] wona. < including deleting files and
] interests bt FLIREH! synchronizs Their Stuff to match Your Stuff. oK folders which you have now
“ | intro.ntmt ir Download 1k
:'3 map.Mml BD Sw:lhr:o:;'hur SIuff to mateh Thair Steff. m removed). You can UPload
“] myphotoshtml [ s e (transfer files to the server)
st = —_LI| ordownload (copy files from
: the server back to your Mac.
Shov More Iafer mation O e U} - Click on Go and Transmit will

update your site.
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@ Subscribe!

Why subscribe?

® 12 issues for the price of 11 (UKonly) &L
@ Every issue delivered to your home!/ ‘" o
@ NEVER miss an issue! -

2| About
Internet Advisor...
Internet Advisor is a monthly beginners' magazine for home Internet
users which helps you get the most out of the Internet. The

magazine is packed with useful advice, step-by-step tutorials,
jargon busters, top Web site reviews and much, much more...

Subscribe Hotline Number: 01458 271110
Subscribe Online: www.futurenet.co.uk
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UK pomainNs: £11.50pPaAa
Includes all Nominet Fees
Set-up fee £29 (one off)

F R EE LIFETIME EMAIL AND WEB FORWARDING

Use your domain name from day one.
Have it pointed at your free web space and receive email.

1 © O M & coMMERCIAL WEB SPACE, UK DOMAIN: £99PA
Includes all Nominet Fees.

Options for Microsoft Front Page.

No set-up fees.

Clients include Virgin Net Limited, OFTEL, Cadbury,
Samsung, MORI, Eli-Lilly, Friends Provident

Es
W in M Aprii and M n Nominet member.
ons. **Price correct at time of going to press, All trade and service marks are acknowledged

Prices exclude VAT, All clients agree

gistered more UK
0 our terms and ¢




